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Send Us Your Comments
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Oracle welcomes customers' comments and suggestions on the quality and usefulness
of this document.

Your feedback is important, and helps us to best meet your needs as a user of our
products. For example:

= Are the implementation steps correct and complete?

= Did you understand the context of the procedures?

= Did you find any errors in the information?

= Does the structure of the information help you with your tasks?

= Do you need different information or graphics? If so, where, and in what format?
= Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell
us your name, the name of the company who has licensed our products, the title and
part number of the documentation and the chapter, section, and page number (if
available).

Note: Before sending us your comments, you might like to check
that you have the latest version of the document and if any concerns
are already addressed. To do this, access the Online Documentation
available on the Oracle Technology Network Web site. It contains the
most current Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number
(optional).

If you need assistance with Oracle software, then please contact your support
representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your
Oracle local office and inquire about our Oracle University offerings. A list of Oracle
offices is available on our Web site at http://www.oracle.com.
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Audience

Preface

This document describes the Oracle Retail Pricing Cloud Service user interface. It
provides step-by-step instructions to complete most tasks that can be performed
through the user interface.

This document is for users and administrators of Oracle Retail Pricing Cloud Service.

This includes merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

s Product version and program/module name

= Functional and technical description of the problem (include business impact)
»  Detailed step-by-step instructions to re-create

= Exact error message received

= Screen shots of each step you take



Improved Process for Oracle Retail Documentation Corrections

To more quickly address critical corrections to Oracle Retail documentation content,
Oracle Retail documentation may be republished whenever a critical correction is
needed. For critical corrections, the republication of an Oracle Retail document may at
times not be attached to a numbered software release; instead, the Oracle Retail
document will simply be replaced on the Oracle Technology Network Web site, or, in
the case of Data Models, to the applicable My Oracle Support Documentation
container where they reside.

Oracle Retail product documentation is available on the following web site:

https://docs.oracle.com/en/industries/retail/index.html

An updated version of the applicable Oracle Retail document is indicated by Oracle
part number, as well as print date (month and year). An updated version uses the
same part number, with a higher-numbered suffix. For example, part number
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all
previous versions.

Oracle Help Center (docs.oracle.com)
Oracle Retail product documentation is available on the following web site:

https://docs.oracle.com/en/industries/retail/index.html

(Data Model documents can be obtained through My Oracle Support.)

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.



https://docs.oracle.com/en/industries/retail/index.html
https://docs.oracle.com/en/industries/retail/index.html
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Price Change Overview

A price change is a permanent change to the retail price of an item. When a price
change is created, the following occurs:

»  The item receiving the price change, by specifying items by parent, parent/diff, or
transaction item.

= Where the price change is occurring, by selecting zones or locations.

= How the price is changing, by selecting a percent or amount change, or a new
fixed price.

= Optionally (based on the 'Allow Multi Unit Pricing’) multi unit price changes are
supported with or without changes to the single unit price.

= When the price change will take effect, by designating an effective date
= Why the price change is occurring, by optionally specifying a reason code

You can use rounding rules to move the new price to established price points, or to
round the price. When a price change is added, it must go through a series of checks
before it can be applied to an item/location. Depending on your user role, you may
not be able to move the retail price to the next status. A change to submitted or
approved status, or from approved back to worksheet, results in a conflict check.

The 'Allow Multi Unit Pricing’ system option allows a retailer to maintain multi unit
pricing for items through the price change process. When this system option is set,
multi unit price changes can be created through the Price Change Wizard dialog, and
can be edited through the Price Change Edit popup called from the Price Change
Group screen.

Price change groups are used to group together multiple price change events for easier
management. Mass maintenance including mass approval of the price change is
supported within the price change group.

When price change events are approved, they are made available in advance of their
effective date to multiple downstream systems for ticketing, and to prepare selling
locations for upcoming changes.

Normally, only one price change for an item/location on a given day is allowed to be
approved; however there can be more than one if an ‘emergency’ price change is
entered and executed by an authorized emergency user. Once the emergency price is
received by the selling system (for example, POS or ecommerce) it will overlay the
other retail price that was received previously.
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Best Practices

Note: When the Reset Clearance with Price Change system option
is set, executing a price change will imply that the item is also no
longer on clearance when the price change goes into effect.

Best Practices

When creating price changes for a group of items, it is recommended to enter the item
data at the highest level possible. For fashion items, this is generally parent item (style)
or parent/diff (style/color), whereas for grocery and hardlines this is generally at the
transaction item level (SKU). This is also true for the selection of locations; it is
recommended creating price events at zone level, rather than by store or warehouse.
This provides the following advantages:

1. Managing price events at the higher levels will increase the usability of the
application by having fewer rows for you to manage. It will also help ensure
pricing consistency for similar items and locations, in line with your company
pricing strategy.

2. The Future Retail tables will have the ability to store data at the highest level
possible which, in turn, will ensure that Pricing Cloud Service will run as
efficiently as possible, including response time for processing and screen flow.

Emergency Price Events

There is a system option called Price Event Processing Days that is set to designate the
number of days required between the current date and the effective date of a price
event. This rule ensures that price changes are created and approved with enough
advance timing that stores and other impacted areas can react accordingly.

However, for situations where price events were missed for one or more items or
locations, emergency price events can be created. This allows you to create events that
go into effect less than the standard number of processing days, which can even
include the current date. A separate security privilege provides the ability to limit the
users that can create these emergency events, while preventing others who have the
ability to create price change events from creating emergency events. For example, if
the setting for price event processing is 3 days, you will be prevented from creating or
approving an event that occurs within 3 days, unless you have emergency security
privileges.

When an emergency price event is created and approved the information is passed to
downstream systems the next time the batch extracts are run. If the price change is to
go into effect on the current date, then the item/location price in Merchandising
Foundation Cloud Service is done on approval, along with any markdowns or
markups in the stock ledger.

Conflict Checking

Whenever a price change is submitted or approved, it will be subject to the conflict
checking process. This ensures that invalid prices, or prices out of alignment with your
pricing strategy, are not sent down to the point of sale. Conflicts that are checked can
be configured using some of the Pricing Cloud Service system options, which are
covered in detail below. It also relies on a calculated "future retail” to help determine
when a conflict has occurred.
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Conflict Checking

Future Retail

When price changes events are approved or unapproved, they can negatively impact
the retail value of an item/location when it goes into effect, which can cause conflicts.
As such, the Pricing Cloud Service module uses these events to calculate a future retail
price for the impacted items and locations on the events. This allows it to have a view
to the regular price on any given day and helps facilitate the conflict checking process.

A roll-up batch ensures the system holds future retail data at the highest level possible.
This batch looks at lower-level timelines and attempts to roll up to a higher level
where timelines match exactly between lower levels and higher levels.

When conflicts occur, the Conflicts window displays the price event at the level of the
timeline where the conflict occurred, which could be higher than transaction item and
location level.
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Conflict Checking

1-4 Oracle Retail Pricing Cloud Service Price Change User Guide



2

Create a Price Change

New price changes can be added to a new price change group or an existing price
change group. Creating a new price change group can be done by selecting the Create
Price Change Group task from the Task List, or selecting the 'Create' action from the
Price Change Group Search screen. Either of these steps create a new Price Change
Group into which price changes can be added by following the steps below (starting
with step 3). Adding a price change is performed using the Price Change Wizard.
There are four potential stops within the wizard:

s Items Page

= Locations Page

s Price Change Page
= Summary Page

1. To add price changes to an existing Price Change group, perform a search for the
price change group that you want to edit. See Search for a Price Change Group.

2. From the search results pane of the Price Change Group Search tab, highlight the
price change group to which you want to add a price change and select Edit from
the Actions menu. The Price Change Group tab appears.

Figure 2-1 Price Change Group Tab
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3. From the Item table, select Add from the Actions menu. The Add Price Change
Wizard launches. Continue with the Add Items.
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Add Items

Add ltems

The initial page in the Price Change Wizard allows you to select the items that you
want to add to the price change.

Figure 2-2 Add Price Change ltems Page
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1. From the Add Price Change Items page, enter the items to add to the new price
change using the following criteria:

Table 2-1 Price Change Iltems Page Fields

Field

Description

Add Items by

The Add Items by field allows you to select a category by which
you can narrow the list of things to add to the price change.
Options are:

" Item
s Parent/Diff
" Item List

= Upload List

Item

The Item field is active if you select Item in the Add Items by
field. Click the magnifying glass to search for an item to add to
the price change.

Parent/Diff

When Parent/Diff is selected for 'Add Items by' the display of
the screen changes, showing an item field and diff type field as
the top row, with a Diffs table directly below. Entering an Item
and Diff type will populate the diff table where diffs can then be
selected. Combinations of the entered parent item and the
selected diffs are added to the Selected Items table when the
apply button is selected.

Diff Type

The Diff Type field is active if you select Parent/Diff in the Add
Items by field.

Item List

The Item List field is active if you select Item List in the Add
Items by field. Click the dropdown to select a defined list of
items to add to the price change.

Source File

Source File is active if you select Upload List in the Add Items
by field. Click Browse to select the file to upload.
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Add Locations

2. Once you have entered your criteria, click Apply to move entered or selected data
for the item selection option to the Selected Items table. In the case of an Item List
or Upload List, the items in the list are populated into the Selected Items table.
Once all your items are added to the price change, click Next. The Add Price
Change Locations page appears. Continue Add Locations.

Add Locations

The Locations page of the Price Change Wizard allows you to define the locations
associated with the price change.

Figure 2-3 Add Price Change Locations Page
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1. From the Add Price Change Location page, select the location type you want to
use for adding locations using the following criteria:

Table 2-2 Locations Page Fields

Field Description

Add Locations by The Add Locations by field allows you to select a category by
which you can narrow the list of locations to add to the price
change. Options are:

s Zone

s Location List
= Store

=« Warehouse

Note: The Warehouse option is only displayed if the Recognize
Warehouses as Locations option is set to Yes.

Zone Group The Zone Group field is active if you select Zone in the Add
Locations by field.
Zone Table The Zone Table is active if you select Zone in the Add Locations

by field. When a zone group is entered, the Zone Table will be
populated with the zones in the zone group.
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Add Price Change Attributes

Table 2-2 (Cont.) Locations Page Fields

Field Description
Apply Locations within The Apply Locations within Selected Zones check box is active
Selected Zones if you select Zone in the Add Locations by field. This checkbox

allows exploding the zone into stores and warehouses for
populating the Selected Locations table. If you have access to
one location in a zone, you can use the zone to create events.

Location List The Location List dropdown list is active if you select Location
List in the Add Locations by field. Click the dropdown to select
from a defined list of locations to add to the price change.

Store The Store dropdown list is active if you select Store in the Add
Locations by field. Click the dropdown to select from a defined
list of stores to add to the price change.

Warehouse The Warehouse dropdown list is active if you select Warehouse
in the Add Locations by field. Click the dropdown to select from
a defined list of warehouses to add to the price change.

2. From the search results pane, select the location(s) to add to the price change and
click Apply.

3. Once all your locations are added to the price change, click Next. The Add Price
Change page appears. Continue with Add Price Change Attributes.

Add Price Change Attributes

The Price Change page of the Price Change Wizard allows you to define the price
change itself.

Figure 2-4 Add Price Change Page
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Note: Fields associated with Multi Unit Pricing will be hidden when
the 'Allow Multi Unit Pricing' system option is unchecked.
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Add Price Change Attributes

1. From the Price Change page, define the information for the price change(s) being
added using the following criteria:

Table 2-3 Price Change Page Fields

Field Description

Effective Date The date on which the price change is set to take effect. Users
have the option to key in a date or select one using the calendar
widget.

Value The Value field provides the options that derive the new retail

price. Users have the option to modify the value. Options are:

= Change by Percent: A percent is defined in the change
value field that is used to calculate the new retail.

= Change by Amount: An amount is defined in the change
value field that adds to (or subtracts from if a negative
value is entered) the retail price to determine the new retail.

n Fixed Price: The item is at a specified retail that is defined
in the change value field.

= Reset POS Price: The item is recognized on a price change
but no change to the retail occurs.

= Multi Unit Fixed Price: The Price Change is only for the
multi unit price of the item.

After selecting the change type, users will enter the actual value
for the change. This field is required entry for every change
type. The field supports up to four decimal places for Change
by Percent value. For Change by Amount and Fixed Price,
decimal placement is based on the currency of selected
locations.

Reason The Reason value defines the reason the price change is being
created.

Users have the option to update this field or remove the value
in this field.

Rounding Rule The Rounding Rule field provides the ability to smooth retails
for an item or location.

Users have the option to update this field or remove the value
in this field.

Impact to Multi Unit Retail | This radio button indicates the type of action to be performed
on the Multi Unit Retail for the items selected for this price
change. Options include:

= Add or Update

n Remove

= No Change
Multi Unit Retail The specified retail for the multiple units of the item.
for (number of units) Indicates the number of units of the item which can be

purchased for the specified multi unit retail.

No label (Multi Unit UOM) | The unit of measure associated with the multi unit retail.

Per Unit Retail A calculation of the retail for a single unit of the multi unit retail
(multi unit retail /number of units)

2. Once all your price change information is entered, click Next. The Add Price
Change Summary page appears. Continue with Review, Submit and Approve.
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Review, Submit and Approve

If you want to skip the Summary Page, you can double click on Finish or select
Submit, or Approve options from the Finish drop down menu.

Review, Submit and Approve

When a price change is added, it must go through a series of checks before it can be
applied to an item/location. Depending on your user role, you may not be able to
move the retail price change to the next status. A change to submitted or approved
status, or from approved back to worksheet, results in a conflict check. A price change
may be in any of the following statuses:

Table 2-4 Price Change Status

Status Definition
Worksheet The price change has been started, but not reviewed or sent out.
Submitted The price change has been completed and is pending review.

Conflict checking may have occurred (depending on the run for
submit system option) for the price change.

Approved The price change has been reviewed and accepted. The price
change is communicated to the locations for which the price
change is effective.

Executed The new prices established are effective for the item/location.
Rejected The price change has been reviewed and declined.
Processing While the price change is being processed through conflict

check the status will be listed as Processing.

The Summary page displays the details of the price change before it is added to the
Price Change Group.

Figure 2-5 Add Price Change Summary Page
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1. Confirm the price change settings and double click on Finish or select Submit or
Approve from the Finish drop down menu. You are returned to the Price Change
Group screen. Your new price change is listed in the Item table.
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Review, Submit and Approve

Note: The Summary Page allows individual price changes to be
removed before they are added to the Price Change Group.

Update Price Change Status for One or More Price Changes

Users have options to perform status maintenance at Item level for one or many items,
at the Item/Location level for one or more Locations tied to an item or they have the
option to update for all displayed records using the page level buttons.

= Updating Group Level Price Change Status
= Update Item Level Price Change Status
= Update Location Level Price Change Status

Updating Group Level Price Change Status
Perform the following procedure to update the price change status:

1. Perform a search for the price change group that you want to update. See Search
for a Price Change Group.

2. From the search results pane, select the Price Change Group for which you want to
update status. and select Edit from the Actions menu. The Price Change Group tab
appears.

Figure 2-6 Price Change Group Tab
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3. From the Price Change Group tab, use the buttons at the bottom of the page to
update the price change group status. Options are:

= Submit All

= Approve All

s Worksheet All (Select from the More Actions button menu.)
= Reject All (Select from the More Actions button menu.)

4, After selecting the status change, click Save to save the updated status and remain
on the Price Change Group Maintenance tab. Click Save and Close to save the
updated status and return to the Price Change Group Search tab.
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Review, Submit and Approve

2-8

Note: If a price change is selected for a status change and the new
status is not valid, the status change is ignored and the price change
will not be updated.

Update Item Level Price Change Status
Perform the following procedure to update the price change status:

1. Perform a search for the price change group that you want to update. See Search
for a Price Change Group.

2. From the search results pane, select the Price Change Group for which you want to
update status. and select Edit from the Actions menu. The Price Change Group tab
appears.

Figure 2-7 Price Change Group Tab
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3. From the Price Change tab, from the Items table, highlight the item or items for
which you want to update status.

4. With the item highlighted, select the desired status update from the Actions menu.

5. After selecting the status change, click Save to save the updated status and remain
on the Price Change Group Maintenance tab. Click Save and Close to save the
updated status and return to the Price Change Group Search tab.

Note: If a price change is selected for a status change and the new
status is not valid, the status change is ignored and the price change
will not be updated.

Update Location Level Price Change Status
Perform the following procedure to update the price change status:

1. Perform a search for the price change group that you want to update. See Search
for a Price Change Group.

2. From the search results pane, select the Price Change Group for which you want to
update status. and select Edit from the Actions menu. The Price Change Group tab
appears.
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Review and Resolve Conflicts

Figure 2-8 Price Change Group Tab
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3. From the Price Change tab, from the Locations table, highlight the location or
locations for which you want to update status.

4. With the location highlighted, select the desired status update from the Actions
menu.

5. After selecting the status change, click Save to save the updated status and remain
on the Price Change Group Maintenance tab. Click Save and Close to save the
updated status and return to the Price Change Group Search tab.

Note: If a price change is selected for a status change and the new
status is not valid, the status change is ignored and the price change
will not be updated.

Review and Resolve Conflicts

Whenever a price change is submitted or approved, it will be subject to the conflict
checking process. This ensures that invalid prices, or prices out of alignment with your
pricing strategy, are not sent down to the point of sale. Conflicts that are checked can
be configured using some of the Pricing Cloud Service system options. It also relies on
a calculated "future retail" to help determine when a conflict has occurred.

When a conflict occurs, a notification is sent to the user who attempted to approve the
price event. The notification allows the user to navigate to the price change group of
the price event with the conflict, and from there they can continue on to the conflict
details screen to review the conflict. After identifying the cause of the conflict, the user
can make adjustments to either the current price event which they are trying to
approve, or to the approved event which conflicted with the current price event and
then resubmit the price event for approval.

Future Retail

When price events are approved or unapproved, they can negatively impact the retail
value of an item/location when it goes into effect, which can cause conflicts. As such,
the Pricing module uses these events to calculate a future retail price for the impacted
items and locations on the events. This allows it to have a view to the regular or
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clearance price on any given day and helps facilitate the conflict checking process.

A roll-up batch ensures the system holds future retail data at the highest level possible.
This batch looks at lower-level timelines and attempts to roll up to a higher level
where timelines match exactly between lower levels and higher levels.

When conflicts occur, the Conflicts window displays the price event at the level of the
timeline where the conflict occurred, which could be higher than transaction item and
location level.

Use Quick Create

The Price Change Quick Create feature is designed as a key entry path for users to
create a regular price change. The Quick Create feature supports grouping multiple
price changes for different items and locations into a single Price Change Group.
Mass maintenance can then be performed on this group later in the workflow through
the Price Change Group Maintenance workflow.

Use the following procedure to quick create a price change:

Note: The Quick Create feature is available in the left pane menu
and can be opened at any time regardless of what screens are open.

1. From the Pricing tab Tasks list, click the Quick Create icon.

Figure 2-9 Quick Create Icon
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The Quick Create pane appears.
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Figure 2-10 Quick Create Pane
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2. From the Quick Create pane, select Price Change from the Quick Create drop

down list.

3. From the Quick Create pane, enter information for the following fields:

Note: Fields marked with an asterisk are required. Fields marked
with a double asterisk means that one of the fields needs to be

populated.

Table 2-5 Price Change Quick Create Fields

Field

Description

Group Description

This field allows for entry of a description that can be used on a
new Price Change group. This description may then be used to
search for the price change or price change group for
maintenance purposes.

Item

The Item field allows for entry of a parent item or transaction
level item. Users may enter a single item or multiple items. If
multiple items are entered a semicolon is used to separate
values. The field will accept up to 4000 characters.

Diff

The Diff field allows for entry or selection of a single Diff Value.
Users have the option to use the list of values to search on Diff
Type to find the Diff value.

Zone

The Zone field allows for entry of one or more zones within a
single zone group If multiple zones are entered a semicolon is
used to separate values.

Note: Either a Zone(s) or Location(s) must be entered, but not
both.

Location

The Location field allows for entry of a location. The user may
enter a single location or multiple locations. If multiple locations
are entered a semicolon is used to separate values. The field will
accept up to 4000 characters.

Note: Either a Zone(s) or Location(s) must be entered, but not
both.
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Table 2-5 (Cont.) Price Change Quick Create Fields

Field

Description

Effective Date

The Effective Date is the date when the price change will go into
effect. Users have the option to key in a date or select one using
the calendar widget.

Change Type

The Change Type field provides the options that will derive the
new retail price. Options are:

= Change By Amount — An amount is defined in the change
value field that either adds or subtracts from the retail price
to determine the new retail. Users should enter a minus
symbol (-) prior to the value to subtract from the retail.

= Fixed Price — The item is at a specified retail that is defined
in the change value field (rounding rule may impact
entered retail). Selecting this option enables the Selling
UOM field. Users have the option to enter or select a UOM
value however the field is not required.

»  Reset POS Price — The item will be recognized on a price
change but no change to retail will occur. Reset POS Price
is hidden unless the user has emergency price change
security privilege.

= Change by Percent — A percent is defined in the change
value field that either adds or subtracts from the retail price
to determine the new retail. Users should enter a minus
symbol (-) prior to the value to subtract from the retail.

Change Value

The Change Value field contains the change by percent, change
by amount, or fixed price value depending on the change type
selected.

s Change by Amount — the amount entered in this field is
added or subtracted from the current retail when the price
change takes effect

s Fixed Price — the amount entered in this field is the new
retail on the effective date.

= Reset POS Price — Change value is null and disabled when
Reset POS Price is selected.

= Change by Percent — the amount entered in this field is the
percentage that the current retail will be changed by to
come up with the new retail (support up to four decimal
places for percent value). The field displays a percent sign
to the right of the right of the field before the per label

Rounding Rule

The Rounding Rule field allows the user to associate a specific
rule with a price change record. Users are allowed to enter a
single Rounding Rule. A rounding rule helps users create a
uniform pricing strategy.

Reason

The Reason field value defines the reason the price change is
being created.

4. Once you have entered all information for the newly created price change record,
click Apply, Submit, or Approve. The new price change is created.

Note:

If you select locations (or zones) with multiple currencies, you

can only choose to create a price change by percent or to reset the
point of sale (POS) price. You cannot create price changes by amount
or for a fixed price across multiple currencies.
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Manage Price Changes

The Price Change Group screen allows you to add or maintain price changes within a
price change group. Each price change will contain items needing a change along with
the locations or zones where the change should be made.

The Price Change Group tab has three modes; Add, Edit, and View. If you enter this
screen in View mode, all maintenance options are disabled and the Save, Save and
Close, and Cancel buttons are replaced with Done. If you enter in Edit mode the
following options are supported:

»  Search for a Price Change Group

»  Create a Price Change

= Modify a Price Change

= Delete a Price Change

= Update Price Change Status for One or More Price Changes

Search for a Price Change Group
Perform the following procedure to search for an existing price change group.

1. From the Tasks menu, select Manage Price Change Groups under Price Changes.
The Price Change Group Search tab appears.

Figure 3—1 Price Change Group Search Tab

Search Afvsnced | Sared Soacn Dutust

Manage Price Changes 3-1



Modify a Price Change

2. Enter your price group search criteria using the following fields:

Note: In order to conduct a price group search, users must enter at
least one of the following; Department, Group, Group Description or
Item.

Table 3—1 Price Group Search Fields

Field Description

Price Change Group The Price Change Group field allows the user to enter a Group
ID to be used in search criteria.

Description The Description field allows the user to enter a description to be
used in search criteria.

Status The Status field allows the user to select a Status to be used in
search criteria. Values for the drop down include: Worksheet,
Submitted, Approved, Rejected, Processing, or Executed.

Effective Date The Effective Date field allows the user to enter or select an
effective date to be used in search criteria.

Conflicts The Conflicts field allows the user to select one of the following
values; Yes, No or NULL (Blank) to be used in search criteria.

Department The Department field allows the user to enter or select a
Department to be used in search criteria. The Department list of
values queries all Departments.

Note: The Department, Class, and Subclass fields display the
translated names if they exist.

Class The Class field allows the user to enter or select a Class to be
used in search criteria. The Class list of values queries all
Classes or all Classes for the entered Department.

Subclass The Subclass field allows the user to enter or select a Subclass to
be used in search criteria. The Subclass list of values queries all
Subclasses or all Subclasses for the entered Class.

[tem The Item field allows the user to enter or select an Item(s) to be
used in search criteria. Users have the option to go directly to
the search icon to look up items.

Diff The Diff field allows the user to enter or select a Diff value to be
used in search criteria. The Diff list of values includes both Diff
Type and Diff Value.

3. Once your search criteria are entered, click Search. The search results are
displayed in the Results pane.

Modify a Price Change

Editing price changes can be performed on price changes in multiple statuses with the
following conditions:

= If the Effective Date is in the past, no changes are allowed unless the status of the
Price Change is Worksheet. If the status is Worksheet, you have the option to
update the Effective Date.

»  If the date that the update is being performed falls within the Effective Date minus
the Price Change Processing Days updates are only allowed for users with
emergency security privileges.
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Perform the following procedure to edit a price change:

1. Perform a search for the price change group that you want to edit. See Search for a

Price Change Group.

2. From the search results pane of the Price Change Group Search tab, highlight the
price change group you want to edit and select Edit from the Actions menu. The

Price Change Group tab appears.

Figure 3-2 Price Change Group Tab
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3. From the Price Change Group tab, you can select either items or locations to edit.
(Locations shown are associated with the row in the items table which has focus.)
Highlight the item(s) or location(s) you want to edit and select Edit from that
tables’ respective Action menu. The Edit Price Changes dialog appears.

Figure 3-3 Edit Price Changes Dialog
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Note:

If a single location is selected for editing, the Clear Reasons

and Clear Rounding Rules check boxes will not appear.
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Note: Fields associated with Multi Unit Pricing will be hidden when
the 'Allow Multi Unit Pricing' system option is unchecked.

4. From the Edit Price Changes dialog, use the following fields to edit the price

change details:

Note: When multiple price changes are selected for editing, fields in
the popup may show up as empty. This indicates that the value may
vary across the selected price changes. Entering a value and updating
will update all the rows, leaving the value empty will leave the values
unchanged on the individual price changes.

Table 3-2 Edit Price Changes Fields

Field

Description

Effective Date

The date on which the price change is set to take effect. Users
have the option to key in a date or select one using the calendar
widget.

Change Type

The Change Type field provides the options that derive the new
retail price. Users have the option to modify the Change Type
value.

Change Type options:

Change by Percent: A percent is defined in the change
value field that either adds or subtracts from the retail price
to determine the new retail. Users enter a minus symbol (-)
prior to the value to subtract from the retail.

Change by Amount: An amount is defined in the change
value field that either adds or subtracts from the retail price
to determine the new retail. Users enter a minus symbol (-)
prior to the value to subtract from the retail.

Fixed Price: The item is set at a specified retail that is
defined in the change value field (rounding rule may
impact entered retail.

= Reset POS Price — The item will
be recognized on a price change
but no change to retail will
occur. Reset POS Price is
hidden unless the user has
emergency price change
security privilege.
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Table 3-2 (Cont.) Edit Price Changes Fields

Field Description

Change Value Users enter the Change Value based on the Change Type
entered, including Change by Percent, Change by Amount, or
Fixed Price. This field is required entry for every Change Type
other than Reset POS Price. The field supports up to four
decimal places for Change by Percent value. For Change by
Amount and Fixed Price, decimal placement is based on the
currency of the selected locations.

= Change by Percent: The percent value entered in this field
is added/subtracted from the current retail when the price
change takes effect. The field displays a percent sign to the
right of the field before the per label.

= Change by Amount: The amount entered in this field is
added/subtracted from the current retail when the price
change takes effect.

s Fixed Price: The amount entered in this field is the New
Retail on the effective date (rounding rule may impact
entered retail).

= Reset POS Price — Change
value is null and disabled when
Reset POS Price is selected.

= Multi Unit Fixed Price — The
Price Change is only for the
multi unit price of the item.

Per (Selling UOM) Users have the option to update this field if the Change Type is
currently set to Fixed Price or the Change Type field is updated
to Fixed Price. For all other change types this field is hidden.

Reason The Reason value defines the reason the price change is being
created.
Users have the option to update this field or remove the value
in this field.

Rounding Rule The Rounding Rule field provides the ability to smooth retails

for an item or location.

Users have the option to update this field or remove the value
in this field.

Clear Reasons The Clear Reasons checkbox displays next to the Reasons field
when multiple items or locations are selected for Edit. If a users
chooses to remove a Reason code for the price change the Clear
Reasons checkbox can be clicked. The value for Reasons will be
removed from price changes selected to edit.

Clear Rounding Rules The Clear Rounding Rules checkbox displays when multiple
items or locations are selected for Edit. When the Clear
Rounding Rules checkbox is clicked the value for the rounding
rule is removed.

Mass Update When more than one price change is selected for edit, this
checkbox allows the user to indicate a desire to mass update the
multi unit pricing values on the selected price changes. When
only one price change is selected for edit this checkbox will not
be displayed
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Table 3-2 (Cont.) Edit Price Changes Fields

Field Description

Impact to Multi Unit Retail | This radio button indicates the type of action to be performed
on the Multi Unit Retail for the items selected for this price
change. Options include:

= Add or Update

n Remove

= No Change
Multi Unit Retail The specified retail for the multiple units of the item.
for (number of units) Indicates the number of units of the item which can be

purchased for the specified multi unit retail.

No label (Multi Unit UOM) | The unit of measure associated with the multi unit retail.

Per Unit Retail A calculation of the retail for a single unit of the multi unit retail
(multi unit retail / number of units)

Note: If you select multiple items or locations to edit, some fields on
the screen will not show a value if there are multiple values for a
particular field. For example, if you select two price changes to edit
and the Value field in both price changes is 10.00 then the Value field
will be populated with 10.00. However, if the price changes have
different values (like 10.00 and 11.00,) then the value field in the dialog
is blank. If you enter a value, both price changes are changed to the
new value. If you do not enter a value, then the original values stay.

5. Once updates are complete on the Edit Price Changes dialog, click OK. The Edit
Price Changes dialog closes and you are returned to the Price Change Group tab.

Delete a Price Change

Users will have options to perform Delete maintenance at Item level for one or many
items or at the Item/Location level for one or more Locations tied to an item.

s Item Level: Users highlight one or more rows on the Items table and click Delete
on the Items table

s Location Level: Users will highlight a single row on the Items table and then
highlight one or many rows on the Locations table and click Delete on the
Locations table

1. Perform a search for the price change group that you want to delete. See Search for
a Price Change Group.

2. From the search results pane, select the Price Change Group from which you want
to delete an item or location and select Edit from the Actions menu. The Price
Change Group tab appears.
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Figure 3-4 Price Change Group Maintenance Tab
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3. From the Price Change Group tab, you can select either items or locations to
delete. Highlight the item or location you want to delete and select Delete from
that tables’ respective Action menu. The Delete Confirmation dialog appears.

Figure 3-5 Delete Confirmation Dialog

Delete Confirmation Q
The selected price changes will be deleted. Do you want to continue?

OK  Cancel

4. From the Delete Confirmation dialog, click OK to confirm the deletion. You are

returned to the Price Change Group tab.
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Upload/Download from Spreadsheet

There is one method for uploading Price Changes into the Pricing system:

s Upload from a Spreadsheet

Upload from a Spreadsheet

The Upload Price Changes window provides the ability to upload price changes via
spreadsheet. In this process, the user uploads price change events using a spreadsheet
(.ods file). The template for the spreadsheet should be configured using the Template
Configuration screen in RMS. A standard template is available to the user for
uploading price change events. The template that is explained in this document is the
standard template that is available in Cloud Pricing.

Perform the following procedure to upload price changes via spreadsheet:

1. From the Tasks menu, select Upload Price Changes under Price Changes. The
Upload Price Changes tab opens.

Figure 4-1 Upload Price Changes Tab
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2. In the Template field, select Price Changes.

3. The Process Description field displays the default process name with the date and
timestamp. You can edit the name of the upload process in this field.

4. In the Source field, click the Browse button to locate the spreadsheet file you want
to upload and click Open.
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5. Select one of the following options:

s Click Upload to upload the file. If errors occur during the upload process, you
will get a notification.

»  Click the Revert icon to clear out the screen inputs.

6. Click Done to close the Upload Price Changes window.

Download Price Changes

View Issues

Table

Perform the following procedure to download price changes:

1. Perform a search for the price change group(s) that you want to update. See
"Search for a Price Change Group" for more information.

2. From the search results pane, select the Price Change Group(s) you wish to
download.

3. Select the Download Selected option from the Action Menu.

4. Select the Price Change template. This will automatically populate the Process
Description field (which you can then change).

5. Select OK.

6. Open the file or save it on your system.

The Data Loading Status window allows you to view the status of the upload and
download processes happening in Pricing, so that you can rectify the issues associated
with the upload/download process.

The window allows you to drill down to the errors or warnings associated with a
selected upload/download request.

You can access the Data Loading Status window from the Task menu, select
Foundation Data > Review Status. The Data Loading Status window appears.

The Data Loading Status window contains the following sections.

= Table
» Data Loading Status Toolbar

The table displays the process, process description, file name, template category and
type, destination, action date and time, status and the user, who initiated the process.

Table - Actions Menu and Icons

Use the Actions Menu and icons to apply actions to the table. You can perform the
actions listed below.
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Table 4-1 Data Loading Status Table - Actions Menu/Icons and Description

Actions Menu/lcons Description

Delete and Delete icon ¥ You can delete a process by using the following steps:

s Select a record in the table.

s Select Actions > Delete or use the Delete icon ¥.

= You are prompted, if you want to delete the record. Select
Yes to confirm the prompt.

s The record is deleted from the table.

Export to Excel and Export ~ You can export the records in the table to a Microsoft Excel
to Excel icon spreadsheet by selecting Actions > Export to Excel or by using
the Export to Excel icon ™.

View Issues and View To view the warnings and errors associated with a selected
Issues button upload/download request:

s Select a record in the table.

= Select Actions > View Issues or use the View Issues button.
The Issues window appears.

s Click Done to close the window.

Data Loading Status - View Menu and Icons
You can customize the view of the table by using the options in the View Menu.

Table 4-2 Table Data Loading Status - View Menu/lcons and Description

View Menu/lcons Description

Columns You can manage which of the columns will be shown in the table
by clicking the Show All and Manage Columns options.

Detach and Detach icon & You can view the table in the application in a separate window
by clicking Detach or by using the Detach icon .

Sort You can sort columns by the following options:
= Ascending

= Descending

= Advanced

Reorder Columns You can reorder columns by clicking the Reorder Columns
option.

Query by Example and You can filter the items by one or multiple column values by

Y clicking the Query by Example option or by using the Query by

Query by Example icon
Example icon T .

Data Loading Status Toolbar

The toolbar contains the following icons and buttons.

Table 4-3 Data Loading Status Toolbar - Icons/Buttons and Description

Icons/Buttons Description

You can access the online help for a particular page by clicking

Help icon @ ) _
the Help icon @.

Refresh icon & You can refresh the window by clicking the Refresh icon. All
entries are reset and not saved.
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Table 4-3 (Cont.) Data Loading Status Toolbar - Icons/Buttons and Description

Icons/Buttons Description

Save Click Save to save the entered records.

Save and Close Click Save and Close to save the entered records and close the
window.

Cancel Click Cancel to reject all entries and close the window.

Done If you open the window in view mode, the Done button is
displayed.

Click Done to close the window.
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Price Inquiry

The Price Inquiry screen allows you to look up the price of an item for a selected date
(or date range) and location or locations. The price inquiry search also supports
searching for multiple items across multiple locations. The results will show the price
of the item(s) at all the locations which match the criteria. The search criteria includes
zone, enabling the user to request the price of an item on a particular date at all
locations in the zone. The date specified can be the current date, a future date, or a past
date. When a future date is specified the results come are the expected price on the
future date based on future retail.

Figure 5-1 Price Inquiry Page
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